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Do not open the Seal of the Question Booklet until you are asked to

\

Question Booklet Code: B ‘ Question Booklet Series No: 1 5 j
. ; o 1 71109

Time Allowed: 150 Minutes Total Questions: 150 . Maximum Marks: 150

There shall be negative marking @ 0.25 mark per question for wrong/multiple answers

- Before answering any question, check the booklet that it contains 16 pages and no page is missing,
mutilated or repeated. In case of defect, get it replaced immediately.

"INSTRUCTIONS FOR CANDIDATES

1. Fill in the OMR answer sheet, mentioning the Roll No. and other data as required in the place(s)
indicated therein. Darken the appropriate circles in blue or black ball point pen only. Do not write
any name / surname or put any symbol sign, slogan, prayer or any mark of identification in the
OMR answer sheet. Do not tampér with the bar-code or any other portion of the OMR answer sheet.
Any such act is liable to render the answer sheet unfit for evaluation. ’

2. Correcting fluid, eraser, blade, books, textual material, script notes / loose paper calculator
document, slide rules, log tables / electronic watches, smart watch, cell phone, pager, other
electrical/ electronic devices etc, are not allowed inside the examination hall. In case the candidate
is found to be.in possession of any of the above, he / she shall be expelled from the examinatior
without any enqunry as to whether the same was / were used by the candidate or not. '

1VEIS

3. A machine will read the coded information. furnlshed by you in the OMR Answer Sheet. If th
information so furnlshed by you is lncomplete or different from what you have glven in the™ T‘\—-
application form, you shall be awarded Zero mark.’ Es

4. Answer must be given by completely darkening one of the four circles / ovals representlng the most
appropriate answer given on the Answer Sheet correspondlng to the relevant question. For answers
not shown by properly darkenlng in black / blue ball point pen, no marks shall be awarded.

5. No Rough work shouild be done on the OMR Answer Sheet Space for rough work has been provided
" in the Question Booklet itself. . . .

6. After the examination is over, candidates must ensure to fold the OMR Answer Sheet at the

- perforation -and separate the Original Copy and Candidate’s Copy of the Two Part OMR Answer
Sheet in the presence of the Invigilator and handover the Original Copy to the Invigilator. The
Candidate’s Copy of the OMR Answer sheet may be taken by the candidate. Failure to hand over
the original copy of the OMR Answer Sheet to the Invigilator before leaving the examination hall /
room shall make the candidate liable for penal action. ’

7. Candidates may take with them the respective questlon -booklet after the examination is over.

8. Failure to comply with or violation of any of the above instructions shall be consndered as adopting
unfair means and action as deemed proper shall be taken.
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CURRENT AFFAIRS

1. Where is India’s largest facility for weightlifting
coming up?

a) Ganjam

b) Imphal

c) New Delhi
d) Bhubaneswar

2. Who won the Best Actress award at Cannes Film
Festival 2024 for acting in film *The shameless’
(royal section)? :

a) Kani Kusruthi

b) Anasuya Sengupta

¢) Divya Prabha

d) Chhaya Kadam

3. Naomi Osaka, famous tennis player returned to

"WTA Tour after a break in January 2024. Why did

she take the break?

a) Injury :

b) Mental health issues

c) Financial issues

d) Legal issues (court case)

4. Ameen Sayani died in February 2024. In which
field did he earn his fame? s
a) Radio announcement -
'b) Singing ;
c) TV Anchor
d) Film Director

5. Manohar Joshi dicil in February 2024. For which

period was he speaker of the Lok Sabha. .

a) 2002 to 2004
b) 2004 to 2006
c) 2000 to 2002
d) 1995 to 2000

6. Who is the Solicitof'Geher_al of India? - .

a) Tushar Mehta
~b) Ranjit Kumar
¢) Mohan Parasaran
d) Gopal Subramanyam -

7. Who is the current Chairman of Security and.
Exchange Board of India? '

a) Madhabi Puri Buch

b) VKSinha =

c) Ajay Tyagi

d) C.B Bbhave

" 8. Who is the chief of Arm

y Staff in June, 20247

a) General Manoj Pande |
b) General Manoj M. Naravane
¢) General Dalbir Singh Suhag

d) General Rakesh Kapoor
9. Who is the président,of Pakistan? -

a) Asif Ali Zardari
b) Imran Khan

¢) Nawaz Sharif
d) Shahbaz Sharif

10.'Palestinian Prime Minister declared his

 resignation in end February and laid down office on

315t march 2024, What is his name?

a) Mohammad Shtayyeh
b) Rami Hamdallan

- ¢) Salam Fayyad

d) Yehia Sinwar

11. Who is the new Prime Minister of Singapore?

- a) 'Lawrence Wong
‘b) Lee Kuan Yew
¢) Gok Chok Tong
d) Lee Hsien Loong

" 12. Alice Munro died in May 2024. In which field
'did she earn her fame? - ; ,

‘a) Literature
b) Acting
- ¢) Painting
d) Politics

" 13. Director of “All We Imagine as Light” won the

Grand Prix at Cannés Film Festival 2024. Who is

~ the Director of the film?

a) Sanjay Leela Bhansali
b) Payal Kapadia
- ¢) Mani Ratnam

d) Anurag Basu -

" 14. New laws replacing IPC, Cr.PC and IEA will
~ come into effect on: = ‘

a) July 12024

b) Junel 2024

c) 31 December 2024
d) 1 January 2025

15. Result of votes counting in which election was .
set aside by Supreme Court in February 20242
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a) Eleclion for Mayor of Chandigarl'l.
b) Elcctgon of Rajya Sabha in Uttar Pradesh
c) Election of MLA in a recent election.

d) Election of Rajya Sabha in Himachal
Pradesh,

16. _Cyclone ‘REMAL’ made landfall in end May.
Which country was most affected by ‘REMAL’?
a) Bangladesh
b) Myanmar
c) Thailand
d) Sri Lanka

17. How many MLAs are clected for Odisha
Legislative Assembly? '

a) 137
b) 147
) 157
d) 142

18. Who is the present Chief Minister of Goa?

a) Pramod Sawant

b) Digambar Mamat
¢) Laxmikant Parsekar
d) Francisco Sardinaa

19. What is the name of Slovakia Prime Minister
who was attacked in May 20247

a) Peter Pellegini
b) Robert Fico

c) Eduard Heger
d) Ludovit Odor

20. Who ‘is the Chairman of DRDO and Secretary of

Department of Defence Research & Development?

a) Dr. Samir V. Kamat -
b) Shri S. Christophar.

c) Dr V.S Arunachalam -
d) Dr. G. Satheesh Reddy

; 21. Who is the Director General of CS_IR and
Secretary of DSIR? A

a) Dr. (Mrs) N Kalaiselvi
b) Dr. R.A Mashelkar

c) Dr. Sekhar C Mande
d) Dr. Girish Sahani

22. Which Covid vaccine manufacturer admitted in

UK Court that said vaccine can in rare cases cause
“Thrombosis with Thrombocytopenia syndrome”?

a) Astra Zeneca/Covishield
b) Covaxin

c) Spﬁtnik -V
d) Janssen

?3. Which is India’s largest Lok Sabha constituency
in terms of voter population?

a) Malkajgiri
b) Outer Delhi
c) Agra

d) Khurda

- 24, Papua New Guinea was affected by a natural

disaster in May 2024 resulting in death of over a

‘thousand. What was the national disaster?

a) Cyclone
b) Flood

c) Landslide
d) Earthquake

25. In Archery World Cup, held recently at
Shanghai, Indian Women’s team won Gold Medal.
Whom did they defeat in final?

a) Turkey

b). France

c) Italy

d) * South Korea

26. Alejandra Rodriguez, a lawyer and journalist
recently won title of Miss Universe Buenos Aires.

“What was her age at the time of winning the title?

a) 27 . |
b) 45 1
c) 25 . |
d) 60

27. A biopic ‘Chamkila’ was made on life of Amar
Singh Chamkila. In what field did late Mr. Amar
Singh Chamkila earn his fame?

,- “a) Singing
b) Sports
¢) Dance
d) Literature

28. In India Super League, whom did Odisha FC
face in semifinal in April 2024?

a) Mohan Bagan
b) Mumbai city
c) KeralaBlasters
d) Goa

29. Who is the Captain of Kolkata Knight Riders,
who won IPL Championship in 2024?

a) Shreyas Iyer

b) Andre Russel
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¢) Phil Salt
d) Varun Chakravarthy

30. Who has been awarded Gyanpith Puraskar for
20237

a) Gulzar

b) Rambhadracharya

c) Botha&b

d) None of the above
31. India’s top Cargo handling port for 2023-24
was:

a) Paradeep Port

b) Kandhra Port

¢) Vizag Port

d) JNPA Port ;
32. As per recent amendment made in Section 14
(b) of Representation of People Act, how many
qualifying dates have come into effect, in place of
one qualifying date, for voter registration?

a) 2 o

b) 3 '

c) 4

d S

33. On which date is National Voters Day !
celebrated in India? ’ ‘

a) 24 January
b) 25 January-
c) 26 January
d) 26 February

34. As per new initiative by ECI, senior citizens -

above certain age can vote from home. What is that

age?

a) Above 80 yéars

b) Above 85 years® : g

‘c) Above 75 years.
d) Above 82 years .

35, ECI has approved 12 alternative identity
documents in place of Voter Identity Card for
identity verification at Polling Booth. Which of the
following is not one of them? ;

a) PAN Card

b) AADHAR Card

¢) Credit Card

d) Driving license

36. What percentage of booths are covered for
webcasting by ECI? -

a) 30%

b) 40%

c) 50%
d) 60%

37. What is the

20247

a) 33236360
b) 733646762
¢) 16850949
d) 32210723

38, Tn how many phases I
‘been conducted in QOdisha?

a) 3 Phases
b) 4 Phases
c) 5 Phases
- d) 2 Phases

total electors of Odisha as on 28.4,

as General Election 2024 -

39, Prime Minister of Greece paid state visit to

b) Alexis Tsipras
c) Joannis Sarmas

d) Kostis Hatzidakis

" India in March 2024. What is his name?
a) Kyriakos Mitsotakis

40, Kolkata Knight Riders won IPL title in 2024.

Who did they defeat in the finals?

a) Mumbai Indians -
b) Sunrisers Hyderabad

¢) Royal Challengers Bengaiuru

- -d) Rajasthan Royals

DATA INTERPRETATION

Directions (Q 41-45) Study the following
information carefully and answer accordingly.

~ Note: Use additional information given in any

question or its answer for answering subsequent

questions.

| Geography (67) |

<

English

Economics
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41. How many students study Geography or
English?

a) 108

b) 91

c) 62

d) 130

42.1f 32 students study only Geography, how many
students study English?

a) 63
b) 67
c) 52
d) 59

43. How many students study Economics or
Geography or both but not all three?

a) 28

b) 90

c) 63

d) 54

44. How many students study only Economics?
a) 15
b) 16
c) 17
d) 18

45. What is the total number of students enrolled for
studying these three subjects, either one of them, |
two of them or all of them? :
) a) 120 :
b) 130 -
c) 123
d) 132

Directions (Q.46-50) Study the table given below-

and answer the following questions. The table gives
" the details about bowling performances of six

bowlers. o
Bowlers | Overs | Maidens Runs Wickets ‘
‘ : Conceded | Taken
Lee 20 5 120 15
Bond | 18 4 72 9
Steyn - 6 - 20
Asif 12 - - --
Amir 24 - - 32
Roch 16 3 96 20

Note: Maiden over is one ‘in which a bowler doesn’t
concede any run.

46. 1f the number of wickets taken by Asif is 16 %

of total number of wickets taken by all the
remaining bowlers and he conceded 7 runs per over
then find his strike-rate. (Strike rate is defined as the
no. of runs conceded per wicket)

a) 5.25

b) 4.25

¢) 6.25

d) 7.25

47. How many more maiden overs should Roch
have bowled in order to equal the economy rate of
Bond? (Economy rate is defined as the no. of runs
conceded per over) '

a)4

b) 6

c)2

d)8

48. If Amir bowls a maiden for every 3 overs he

~ bowls and concedes 33 %% more runs that Lee did

~ then find the ratio of his maidens per wicket to the

runs conceded by him per overs?
| a) 5:71
b) 3:71
- ¢)3:80
d) 5:81

49. If Lee and Steyn collectively bowled 36 overs
-and conceded 280 runs, then find the ratio of their

strike rates. (Use information from previous

- questions if needed)

a) 2:1 : g
b) 1:1 ‘

c)3:1

d) 1:4

50. Strike-rate of Amir is what percentage of the
economy rate of Roch? (Use information from
previous questions if needed) -

a) 90%

b) 83.33%

c) 85.25%

d) 88.75%

BHKL/Eng/B-5

3@ Teachingninja.in



. CON i intormation ¢
Directions (Q 51-55): Read the given data carefully  Directions (Q- 56'60)_‘ Study tl?e given | s
and answer the given questions. - ‘ and answer the following questions.

Given below is the table which shows the different There are three types Of"eh.ides ie.,3 Aut;),.4t§ar ;
types of work A, B, C, D and E; ratio of efficiency and one Truck which take rlfies every day. 1stance |
to do these works, of a man, a woman and a child covered by each type of vehicle per f‘de' 15 Sami_‘{' ?
respectively and total time taken by a child to Profit per ride of an Auto and a Car 1s glver; f:lrs 1 /
complete these different works, - 20 and Rs 60 respectively and total profit of Truc '
: : - in April month is given as Rs 4200. Ratio of total [
Work Pl Time Taken by a child ride per day of an Auto to total ride per day of a car ;
efficiency to complete work. is 3:2. Ratio of per ride profit of a Truck to per ride .
- (M:W:C) o profit of a car is 70:30 and total profit is given as Rs
A 5:3:4 20 days 15980 per day.
B - 4:3:2 10 days ) : -
C 8:7:6 21 days : 56. What is-the difference in profit earned by all
D 3:2:1 15 days : Cars and Truck in one day? :
E 6:4:3 .. 16days " a)Rs 13,660
‘ - e b) Rs 12,120
51. What is the time taken to complete work Aby 3 ¢) Rs 14,120
men, 2 woman and 1 child together? . e d) Rs 11,380
- a) More than 4 days bl ‘ : ‘ ,
b) More than 5 days 2 .. 57.What is the ratio of profit eamed by a carin a
c) More than 3 days g aasi e hat d by an Auto in a day?
~ d) More than 6 days = ) ayto (g SgEC by an A ¥
‘ . 7 : ] - all:9
52. What is the time taken by.a Man to complete =~ - D) 2:1
-Work B? _ REAE IR ST o W B
- a) 4 days ; y QS 91319
. b) 10 days SRR S ¢ % AR SRR ey ,
c) 5 days. ; O ~ 58. What is the total profit of a single Car, Truck
d) 6 days Gl AT @ and Autoinaday? = . . '
‘ ey LN s 2 ) Rs 4860 é: 3 SRR R
53. In how many days ¢an 2 men, 3 womenand 3 St b)Y Rs 4460 oL e : ) |
children,)cgn;pletc_: work D? l &8 LA L  ©)Rs 4240 L i |
- a)6days - . b4 _ L i :
b) 4 days - s v ke 9 RS 5620 :
_ :3? g?}/’s . 59. What is the contribution of cars(approximately) 3

54. Out of works A,B,C,D, vi{hic_:h wdrk aman takes. s O the total income per day in percentage?

most days to complete? s . a) 68%
DA L A e ) T
BB el T T 10)  T5%
¢)C TR | Ay 8%

d)D | ey N SLgEL ,

55. One Man, One Woman and One Child working - 60. What is the total profit
together get 1200 Rs in total for completing work A i the month of April? -
and 600 Rs for completing work D. What is the : ' :

earned by all the Autos

\

amount received by a child for completing both a) 192,600
works (in Rupees)? : 3 b) 162,900
a) 200 ' : c). 129,600
b) 300 g e d) 169,200
c) 400 ‘
d) 500
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Directions (Q 61-65): The following bar graph “a) 10%

shows the Income and Expenditures (in lakhs) b) 20%

of five companies in the year 2001, c) 25%

The percent profit or los 3o b 0

mcome_ﬁperd‘mre ss of a company is given by d) 30%
Income X 100'

: : 65. If the income of the Company Q in 2000 was
On the basis of the given dat: ] . pany CIn
questions. given data, answer the following 10% less than its income in 2001 and the

Company had earned a profit of 10 Lakhs in
2000, then what was its expenditure in 2000(in

Income and Expenditure (in Lakhs) of five coinpanies in the year Lakh 8)?
2001 .
& » a) 28
50| - b) 30
S0 45 — i 45 g 45 — c) 32
40 a0 40
a0 3 _] iy d) 26
20 B _ ,
20 : 1 B | Directions (Q 66-70): The following table
10 s N | B4 | || | givesthe percentage distribution of population
. RN B | offive states: P, Q, R, S and T on the basis of
T N. » o  .m | povertyline and also on the basis of gender.
mEtandie. Chvcdiné ' On the basis of the data given in the table chart,

. | answer the following questions.
61. What was the percentage profit/loss of the : ' ‘

companies M and N taken together ? .. ‘ Proportion of
' a) 12% loss. | . i o Males and Females
0 T
‘c’; e L“;Sf-i e Lo Eremage of | Below | Above
. : _ : - population Below : :
d) There was no loss or profit. ' ‘Poverty Line Poverty LingiPovertyzline
62. In 2001, what was the approximate M: X M: B
percentage of profit/loss of all the five P ‘48 5:6 6:7
Companies taken together ? Q .20 - 3:5 4:'5
a) 4.65% profit. R 25 2:3 1: 2
* b)r 6.5% profit. S 19 3:2 4:5
c) 4% loss. T _ 10 8:3 3:2

d) 7% loss. _
66. If the male population below poverty line

63. Which company earned the mgmmum for the state R is 4 million, then what is the total
per centage)pr](\flt in the year 20017 population of the state R ?

2 4 S ; a) 40 million.

b) N SR , b) 48 million.

o Q : £ o ¢) 50 million.

d P ‘ H . d) 60 million.

64. For the Company R, if the expenditure had

increased by 50% in year 2001 fro'm year 2000 67. What will be the number of females above
and 'the income increased by 25% in year 2001~ 4. poverty line in the state S, if it is known that
from year 2000. Then what was the profit  * the population of the state S is 100 million ?
percentage in the year 2000 ? © . a) 57 million,

’ : b) 45 million.
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¢) 36 million.
d) 48 million.

68. If the population of males below poverty
line for the state Q is 2.4 million and that for

the state T is 6 million, then what is the ratio of

the total populations of the states Q and T ?

a) 1:3
b) 2:5
¢ 3:7
d 4:9

69. If the male population above poverty line for the
state P is 12 million, then what is the total
population of the state P?

a) 40 million
b) 50 million
c¢) 60 million
d) 70 million

-70. Using the answers obtained from above four
questions, calculate the ratio of total populatlon of P
to the total populatlon of R? :

a) 3:5

b) 5:4 .

c) 5:6
- d) 67

'LOGICAL REASONING.

71.1fina certain code, TREE is written as UQFD, - |

then how is LEAF written in that code?

a) MFBG SRR ‘et

b) MDBE
¢)- KDZE
d) MBZE

72. A man walks 1 km to Eaét, then 'hglturns to
South and walks 5 kms. Again, he turns to East and

walks 2 kms. After this, he turns to north and walks-

9 kms. Now, how far is the man from the startmg
point ? :

a) 3 kms,
b) 4 kms.
¢) 5kms,
d) 7 kms.

73. Using only 2, 5,10, 25 and 50 paise coins, what
will be the minimum number of coins required to
pay exactly 78 paise, 69 paise and Rs 1.01 to three
different persons?
- a)l9
b) 20
c) 17
- d) 18

74. A test has 50 questlons A student scores 1 mark
for a correct answer, - ~ for a-wrong answer and - =

for not attempting a questlon If the net score of a
student is 31, and he has not attempted 6 questions,
then number of questions answered wrongly by that

student is: ‘ ‘ ‘
' a) 6 . ' ‘%
b) 12 -
c). 3% W » :
d 9

75. Here are some words translated from an

artificial language.

- ‘dionot’ means Oak tree
‘ ‘blyonot’ means Oak leaf
‘blycrin’ means Maple leaf

. Which word could mean “Maple Syrup '

~a) blymuth

" b) hupponot -
¢) patricrin -
d) wellbly

76. If the word ‘EXAMINATION’ is coded as . {

56149512965 ‘then the word ‘GOVERNMENT 1S
coded as:

a) 764595,4552

*'b) 7654694562
c) 7645965426
d) 7654964526

77. A clock strikes once at 1 ¢’ cloék, twice at 2 o’

* clock and so on. If it takes 6 seconds to strike at 3 o’
" clock, then in an entire day of 24 hours. How much

tlme is spent on striking of the Clock?
a) 5 minutes 12 seconds
b) 4 minutes 6 seconds
‘c) 3 minutes 20 seconds
d) 5 minutes 32 seconds
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78. There
numbers.

102
09 90 07

Tl}c tcﬂ one is complete whereas one number is
missing in the right one. Find a suitable number to
fill in the place of the question mark.

a) 280
b) 303
c) 362
d) 382

are two similar figures below with some

79. Which number should come next in the series:
46, 44,40, 38 34 )
\

L3 0%
b) 30
c) 32

“d) 36

80. The pair PETAL : FLOWER has certain-
relationship to each other. Select the pair
from the options given below w1th the same
relationship. '

a). Pen : Paper
b) Engine : Car
¢) Cat: Dog

d) Ball: Game

Dlrectlons(Q 81-85): Refer to the followmg data
and answer the questions that follow.

A numerical machine accepts two values X and Y
. Then it updates these values as ~
X=XYand Y=Y + 1 in every step.

The machine stops at X > N.

81. For X =3, Y =2 and N = 100, what is the value
of Y when the machine stops? .

a)2
b) 3
c)4
d) 6

82. In the above question, what is the final value of
X when the machine stops?

a)6

b) 20

)72

d) 360

83. In the above question, what is the value of X
after Step 1? '
a)4
b) 5
c)6
d) 20

84. If the value of N is changed to 500, what would

 be the final value of X?

a) 3160
b) 2500
¢) 1560
d) 2160

85.If X =2,Y = 3 arid N=500, what would be the
value of X when the value of Y'is 77
. a) 300
b) 360
c) 720
" d)860

86. Compiete the series: |

CKDL, EKFL, GKHL, , KKLL
from the options given below.

a) DKL
" b) MNOP*
c) MNPQ'’
- d) IKJL

87. The pair PAIN:SEDATIVE has certain
relationship to each other. Select the pair

- which has the same relationship.

a) comfort : stimulant
b) grief : consolation
c) trance : narcotic
d) "ache : extraction

88. Pointing to a woman, a man said, "Her
father is the only son of my father." How is
the man related to the woman ?

a) Brother
b) Grand father
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c) Father
d) Son

89. Arrange the following words in a meaningful

sequence.

1.Cow 2.Grass 3.Milk 4, Curd

a) 1,3,2,4
b) 4,3,2,1
) 3,4,1,2
d 2,1,3,4

90. A man walks 5 km toward south and then
turns to the right. After walking 3 km, he
turnsto the left and walks 5 km. Now, in
which direction is he from the startmg place?

a) South

b) South-West
¢) North-East
d) West

91. Pick the odd one out from the given palr of
words.

a) Docile: Submissive
b) Stringent : Flexible
c) - Steadfast : Irresolute
d) Monotonous : Exciting -

92. If "HARYANA" is written as "8197151"
in a certain code; then how is "DELHI"
written in that code ? . ik

a) 53289

b) 45389 °
. c) 34589

d) 56789

.93, Choose the letter pair Whlch is dlfferent from '

others in the group.

a) BD ' P¥ S
b) IK - '

c) PN

d) SU

94, Find the mlssmg letters in the series:
DFH, HJL, LNP, , TVX
. from the options given below.

a) DTV
b) NRT -
¢) PRT
d) RQS

95. Rita told Mani “The girl I met yesterday
at the beach was the youngest daughter of the
brother of my friend’s mother.” How is the
gir] related to Rita’s friend ?

a) Cousin

b) Daughter

. ¢) Mother
d) Aunt

- 96, Ram is facing north. He then turns 45 in the

clockwise direction and then again turns 180° in the

same direction. He then turns 45° in the anti-
clockwise direction. Find the direction he is facing
now ?

‘a) East

b) West
¢) North
d) South.

97. A dice is numbered from 1 to 6 in different
ways. If 1 is adjacent to 2, 3 and 5, then which
one of the following optlons is necessanly true ?

a) 1is adjacent to 4.

b) 2 is adjacent to 5.

¢) 1 isadjacent to 6.

. d) 4 is adjacent to 6

) Dlrectlons (Q 98-100) Read the passage glven

below. and pick out the correct opt1on for the- glven
questions. - :

Five roommates Ranveer, Salman , Tiger, Upen
and Varun each do one housekeeping task:

. mopping, sweeping, laundry, vacuuming, or

dusting one day a week, Monday th:ough
Friday. :

+ Varun does not vacuum and does not do his task on
Tuesday. -

< Salman does the dusting, and does not do it on
Monday or Friday.

+ The mopping is done on Thufsday

+ Tiger does his task, which is not vacuummg, on

Wednesday.

+ The laundry is done on Friday, and not by Upen.
. Ranveer does his task on Monday.

98 Which day does Upen do his task ?
a) Friday
-b) Thursday
c¢) Tuesday
d) Monday
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¥¥. what task does Upen do?
) Mopping
b) Laundry
¢) Sweeping
d) Dusting

100. Which day does Salmar
a) Friday
b) Thursday
¢) Tuesday
d) Monday

1 does his task?

ARITHMETIC |

101. What is the value of the followmg
expression:

[26 + {42 %(23 —20) +2 - (2 x (5 x80 —100))
+16 —4}]? :

a) —434-
b) 434

c) —443
d) —453

102 What is the number when multlplled by 16
increases by 540 ?

a) 30

b) 36

c) 42

d) 46

103. What is the dlfference in the place value of 5 in

the numeral 7548537
a) 45000
b) 49500
c) 49940
- d) 49950

104. If two-third of three-fourth of a_

number is 34, then what is the value of .
20% of thatnumber ?

" a) 13

b) 13.6

c) 14

d) 14.6

“105. If x = 0. 84181 is expressed-as a fraction in
the lowest terms, then the denominator exceeds
the numerator by: -

a) 15803
" b) 18503
c) 13580
d) 10583

106. The approximate value of
0.4 x0.4 +0.04 x0.04 +0.04 is:
a) 0.16
'b) 0.20
c) 0.38
d) 0.46

107. The population of a town is decreasing at a rate of
10% per annum. If the population 2 years ago was
20, 000, then what is the present population ?

a) 15,000 '

b) 15,200

c) 16, 000

d) 16,200

- 108. Anil’s salary was Rs.18, 000. An increase of

20% each in two consecutive years is equal to a
single increment of what percentage ?

a) 22% .

b) 32%

c) 40%

d)- 44%

. 109. A certain amount of mohey was invested on
- simple interest at a certain rate for 2 years.If it had
... beeninvested at 4% higher rate, then it would have

fetched Rs.480 more, then what is the amount of

. money invested?

a) Rs.6,500
b) Rs.6, 000
c) Rs.5, 600
d) Rs.5,300 -
110. On lendiﬁg a certain sum of money on
compound interest, one gets Rs.9050 in 2 years -
and Rs.9500 in 3 years. What is the rate of
interest (approximately)?
a) 6%
b) 5.5%
c) 5%
d) 4.5%

111. X’s and Y ’s shares in a business are in the

“ratio of 5:3.IfX has invested Rs. 70, .000 for 12

months, then for what period of tlme Y has
invested Rs.60, 000 ?
@) 6.4 months

b) 7.4 months

¢) ‘8.4 months

d) 9.4 months
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112. The sum of the present age of mother and
her son is 60 years. Six ycars ago, the age of the
mother was five times the age of her son. What
will be the age of her son after 6years?
" a) 23 years

b) 22 years

¢) 21 years

d) 20 years

113. The day on 5™ April of a year will be the
same day on 5t of which month of the same year
?
.a) 5t June
b) 5t July
c) sth August
d) 5t october

114. A man swims 12 km downstream and 10 km
upstream. If he takes 2 hours each time, then
what is the speed of the stream ?

a) 1.5 km/hr.

b) 1.7 km/hr.

¢) 0.7 km/hr.

d) 0.5 km/hr.

'115. How many times the hands of a clock coincide

in a day (or 24 hours) ?
a) 24
b) 23
c) 22
d) 21

116. Sachin scored a century which included 3
fours and 8 sixes. As a result, what percentage of- -
his total score did Sachin score by running - - - '
between the wickets ? g

a) 40 '

b) 45

c) 50

d) 55

117. A pipe can fill a tank in 6 hours and another .
pipe can empty the tank in 12 hours. Ifboth the -~

pipes are opened at the same time, then the tank

can be filled in how many hours ?
a) 10 hours
b) 12 hours
¢) 14 hours
d) 16 hours

a TV for Rs.8, 000 and sells

h purchases
118. A man p the selling price of the T.V.?

it at 10% loss. What is
a) Rs.7,200
'b) Rs.7,000
c¢) Rs.6,900
d) Rs.6, 500
119. A car takes 2 hours
travelling at the speed of
hours) will it take when t
of 80 km/hr?

to reach a destination by
60 km/hr. How long (in
he car travels at the speed

120. A tram is moving at 120 km/hr. The length
of the train is 150 meters. How long it will take
to cross a platform of length 100 meters ?

a) 7.5 seconds.

b) 10 seconds.

c) 20 seconds.

d) 25 seconds.
121. P can do a job in 12 days and Q can do the
same job in 10 days. With the help of R,they
can do the same job in 4 days. In how many days
R alone can do this job 7 S

a) 12 days.

b) 13 days.

c) .14 days.

d) 15 days.
122. A shopkeeper mixes 60 kg of sugar priced
Ri.30 per kg with 90 kg of sugar priced Rs.40
per kg. At what rate he must sell the m1xture to
gain 20% ?

-a) Rs.30 per kg

b) Rs.34 perkg.

c) - Rs.38 perkg.

d) Rs.43.2 perkg.

. 123.1f (V3) x 92 =3 x 343, thenxequals to:
.ma)3
b) 4 -
Q5
d) 6
124. The LCM of two prime numbers x&y is 161
If x >y, then the value of 15y —7x is: ~
a) —32
b) —56
c) 38
d) 74
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125. A blanket, when bleached, decreases in
length by 20% and in breadth by 15%. What is
the percentage decrease in its area ?

a) 32%

b) 35%

c) 42%

d) 45%

126. A bag contains Rs.410 in the form of Rs.5,
Rs.2 and Re.1 coins. If the number of coins is in

the ratio 4 : 6 : 9 respectively, then what is the
number-of 2 rupees coins ?

a) 40
b) 50
c) 60
d) 70

127. In a 100 meters raée, P covers the distance

in 36 seconds and Q covers in 45 seconds.In this
~ tace, P beats Q by:

a) 9 meters.
b) 20 meters.
c) 22.5 meters.
d) 25 meters.

128. How many numbers from 1 to 20 are eithe'r
a multiple of 3 or5 ? '

a) 9
b) 8
c) 6
d 5

129. What is the length of the longest rod that can =

"be placed in a room 30 meters long, 24 meters
broad and 18 meters high ?°
. a) 30 meters.
b) 15v/2 meters.

©) 30vV2 meters. -
d) 60 meters.

130. The numerator of a fraction is 3 less than thg:
denominator. If the numerator be made 3 times
and 20 is added to the denominator, the fraction -

becomes g. What is the fraction?

- a) i ]
b) =
c) %
dy =

using

COMPUTER AND INTERNET AWARENESS

131. IPv4 address is:
a) 8 bit
b) 16 bit
c) 32 bit
d) 64 bit

132. Which of the following is used to create or
design a web page?
.a) HTML
b) HTTP
c¢) PPP
d) WwWWwW

133. An identifier that sends and receives
information across the Internet is called:
a) IP address
b) www
c) Network
d) URL

134. What is the full form of NIC?
a) Network Interconnection Card
b) Network Internet Card
¢) Network Interface Card’
d) Network Intra Card

135. Wthh view allows to modlfy table’s
structure in Access?
-a) Design view
b) Datasheet view
c) Pivot table view
d) Pivot Chart view

136. Which key sfroke v‘moves' the active cell

- towards left in Access table?
a) F2

b) FS5 -

'c) Tab

d) Shift + Tab . ~

137. Which cornbmatmn of key zooms the
" content of active cell in Access table?
a) Ctrl +F2
- b) Ctrl + F5
- ¢) Shift + F2
-d) Shift + F5

138. In MS Access, form diélog may be created
menu.

. a) Create>More Forms>Form
Wizard

b) Create>More Forms>Data Sheet
. BHKL/Eng/B-13
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c) Create>More Forms>Modal
Dialog
d) Create>Blank Form

139. To open the existing presentation, press:
a) Ctrl + L
b) Ctrl + N
c) Cul+ A
d) Ctrl+ O

140. The File that consists of readymade styles that
we can easily use for our presentation is known as:

a) Pre formatting
b) Template

¢) Wizard

d) AutoStyle

141 In Microsoft PowerPoint i in order to see all the
slides on one screen use:

-

a) view slide sorter
b) view slide

© ¢) view master
d) view slide show

142. Whlch is the menu command to recolor a -
picture on a slide? ‘

a) Insert -> Picture -> Recolor -

b) Tools -> Picture -> Recolor -

c) Format -> Picture -> Recolor

d) Edit -> Picture -> Recolor . il — "

143. How can you update the values of formula
cells if Auto Calculate mode of Excel is dlsabled‘?
a)F8

- b)F9

c) F10

d)F11

144, You can convert existing excel worksheet data.

and charts to an HTML document by us1ng
a) FTP wizard

b) Internet assistant wizard
¢) Intranet wizard .

d Import wizard

145. What is the short cut key to highlight the entire <

‘column in Excel?

a) Ctrl + C

b) Ctrl + Enter

c) Ctrl + Page Up
d) Ctrl + Space Bar

146. Which of the following is an example of Page
Orientation? ,
a) Landscape

b) Subscript

c) Superscript

d) Ad

147. You can Select all the text in MS Word
document by:

a) Ctrl +S

b) Ctrl + A

c) Ctrl+V

dycul+ 1

148. How can you apply exactly the same
formatting you did to another text in MS-word?

. a) Copy the text and paste in new locatlon Then

type the new text again ,

b) Copy the text and click on Paste Specml tool in
new place . :
c) Select the text then click on Format Palnter and
select the new text ' "
d) All of above

149, To use your keybbard instead of the mouse to

‘select tools on the nbbon you display the KeyTips

by pressingthe - key
a) Alt 2

' b) Ctrl

c) Shift + Enter
d) Alt + Enter

© 150. Ifyou need to change the typeface ofa

. .'document which menu w111 you choose"
a) Edit

b) View
c) Format ~
d) Tools .
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